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Installation tips and troubleshooting

If you're having trouble installing Publisher, this section contains tips that may help solve the problem.

You think your floppy disks or compact disc may be bad or damaged
There is not enough space on your computer's hard disk to install Publisher
You are having trouble with the Setup program and your computer is using virus protection software
The Setup program will not let you install Publisher to a root directory, such as C:\ or D:\
Setup takes a long time
Setup prompts you to insert a Windows disk or compact disc
Setup turns off your screen saver
Do NOT check Publisher disks for viruses
Check your hard disk for viruses before running Setup
Directories with extended characters



You think your floppy disks or compact disc may be bad or damaged

To check whether a floppy disk is damaged
1 Insert the disk you into your floppy disk drive.
2 On the Windows taskbar, click the Start button and point to Programs.
3 Click Windows Explorer.
4 Click the drive your floppy disk is in, and then select the file(s) listed. 

To select all of the files listed, click the first file, hold down the SHIFT key, and then press the END 
key.

5 On the Edit menu, click Copy.
6 In the Explorer window, click the Windows directory.
7 With the right mouse button, click the Temp directory, and then click Paste.
8 Check to see if the files were copied into your Temp directory. If they are not there, or if you get an 

error message while copying, you may have a damaged disk. 
To order another set of disks, call the Microsoft Order Desk at (800) 360-7561 between 7:00 A.M. 
and midnight Eastern time, Monday through Friday.

To check whether a compact disc is damaged
If you get error messages while trying to install Publisher or to read files from your compact disc, please 
check the back of the disc for marks or smudges. These may prevent the laser from correctly reading 
your disc. 
· Try cleaning the disc, following the directions given by the manufacturer of your CD-ROM drive. 

Then insert the CD into the drive again.

If this doesn’t solve the problem, or if you notice large scratches or marks on the disc, you may have a 
damaged disc. To order another compact disc, call the Microsoft Order Desk at (800) 360-7561 between 
7:00 A.M. and midnight Eastern time, Monday through Friday.



There is not enough space on your computer's hard disk to install Publisher

If there is not enough space on the drive where you want Publisher installed, you'll need to either make 
room on that drive, or choose another, before trying to install Publisher again. If you've made these 
changes and you still can't complete the installation, check to see if one of the following is the problem:

There isn’t enough space on your hard disk to run Setup
You will need at least 2 MB of space on your main hard disk (usually C:) to run Setup, in addition to the 
space required to install Publisher, even if you are installing Publisher on a different drive.

There may not be enough space on the drive that contains Windows
If there is enough space on the drive where you want Publisher installed, there may not be enough 
space on the drive that contains Windows. You will need to free at least 7 MB of space on the drive that 
contains Windows for the Setup program to install ALL of the Publisher utility and system files. You'll 
need less if you don't want to install the text converters, the fonts, the graphic filters, the speller, the 
Setup files, mail merge components, or Microsoft Draw.



You are having trouble with the Setup program and your computer is using virus 
protection software

Publisher's Setup program will not install Publisher to a machine with virus protection turned on. In order 
to successfully install Publisher, you need to remove the virus protection software from memory.

To remove the virus protection software from memory
1 Restart your computer.
2 Disable your virus protection software. See your virus protection software manual for instructions.
3 Restart your computer again.
4 Run the Setup program again.
5 After Setup has completed, turn on your virus protection software again. See your virus protection 

software manual for instructions.



The Setup program will not let you install Publisher to a root directory, such as 
C:\ or D:\

Microsoft Publisher will not install to the root directory of a hard disk. Publisher must be installed in a 
subdirectory. This is to prevent you from overloading the root directory on your computer.



Setup takes a long time

Although the setup process may be taking a long time, there isn’t necessarily a problem. As long as 
there is occasional movement of the setup progress bar, Setup is probably working correctly.

The setup process is complex, and the large number of files included in the Publisher package, such as 
fonts and clip art, may require 15 minutes or longer to install, depending on the type of computer.



Setup prompts you to insert a Windows disk or compact disc

While running the Setup program for Microsoft Publisher 97, you may see the following message:

“Publisher 97’s Outside Printing feature helps you create publications that will print well at commercial 
printers and service bureaus. In order to install this feature, Setup requires files from your Microsoft 
Windows disks or network installation share. Do you want Publisher Setup to install this feature?”

If you choose Yes, Publisher will ask you to insert one of your Windows disks or the Windows compact 
disc. Publisher then installs two PostScript printer drivers that you may need if you want to use a 
commercial printing service.



Setup turns off your screen saver

Screen-saver software can interfere with the setup process, so Setup automatically turns off your screen 
saver while installing Microsoft Publisher. Setup will restart your screen saver after installing Publisher. If 
your screen saver does not start automatically, you can restart it manually after Setup is finished.



Do NOT check Publisher disks for viruses

Your Publisher floppy disks have already been checked for viruses by Microsoft. Do not check them for 
viruses yourself. Virus-checking software can corrupt the disks and prevent you from successfully 
installing Publisher.



Check your hard disk for viruses before running Setup

We recommend that you check your hard disk for possible virus software before installing Microsoft 
Publisher. A virus on your hard disk can prevent a successful installation of Publisher.



Directories with extended characters

Microsoft Publisher does not recognize directories with extended characters such as accent marks. 
When naming directories, you may use the letters A-Z, the numbers 0-9, and spaces. 



Converting previous WordArt objects to WordArt 3.0

Publisher 97 includes WordArt 3.0. Publisher automatically converts WordArt 2.0 objects to WordArt 3.0 
objects. 

If you want to take advantage of new WordArt features with WordArt 1.0 objects, you'll need to convert 
WordArt 1.0 objects to WordArt 3.0. If you want keep your WordArt 1.0 objects the way they are, that's 
fine. Publisher will continue to use WordArt 1.0 for the objects you've already created.

To convert WordArt 1.0 objects to WordArt 3.0
1 Open the publication containing the old WordArt objects you want to convert.
2 Select a WordArt object to convert. You'll need to convert WordArt objects one at a time.
3 On the Edit menu, click Microsoft WordArt Object. Publisher displays a second menu of commands.
4 Click Convert.
5 Under Object Type, click Microsoft WordArt 3.0.
6 Click OK.

Notes
· If you convert an object from WordArt 1.0 to WordArt 3.0, you will not be able to convert it back.
· If you want to use WordArt 1.0 in Publisher 97, click Insert Object on the Edit menu, click Microsoft 

WordArt, and click OK. 



Importing files from Ami Pro or Word Pro for Windows

If you have a file created in Ami Pro or Word Pro for Windows, you must save it in Rich Text Format 
(RTF), and then import it into your publication.

To save your Ami Pro or Word Pro document as an RTF file
1 In Ami Pro or Word Pro, open the file you wish to convert.
2 From the File menu, choose Save As. Ami Pro or Word Pro displays the Save As dialog box.
3 In the List Files Of Type box, choose RTF (Rich Text Format).
4 In the File Name box, type the new name. Make sure it is not the same name as the file you 

opened. For example, if you opened README.SAM, save the file as README.RTF.
5 Click OK.
6 You can now import the file into your publication.



Clip Art license

Photo images used in this product are supplied by PhotoDisc, Inc. ©1996.

You are free to use Publisher's clip art or digitized stock photo images for any publication that you print 
or for any Web site (electronic document) that you create. You may not, however, sell or distribute 
Publisher clip art electronically as software, such as in a clip art library.



File previews and ways to save time and disk space

Publisher helps you identify files by saving a preview image with the file. However, it takes time and disk 
space to generate this image each time you save the file. If you are concerned about saving time or disk 
space, and you are willing to do without the file preview, you can tell Publisher not to save the preview 
with the file.

To turn file previews on or off
1 Open the file you want to save.
2 On the File menu, click Save As.
3 Click the Save Preview box to remove the check mark.
4 Click OK to save the file.
5 If Publisher asks if you want to overwrite the existing file, click Yes.

Note
· This setting automatically applies to all Publisher files. Therefore, if you save a publication without a 

preview and then save another publication, Publisher will not save a preview of the second, either.



Working with links to files created in other programs

These procedures apply only to links to files created in other programs.

To cancel a link
1 In Publisher, click the linked object to select it.
2 On the Edit menu, click Cut.
3 On the Edit menu, click Paste Special. Publisher displays the Paste Special dialog box.
4 In the As box, click Picture, and then click OK.

To replace an existing link with a different link
1 Switch to the application in which the file you want to link to was created.
2 Open the file you want to link to.
3 Select the information you want to link to.
4 From the application's Edit menu, choose Copy.
5 Switch to Publisher.
6 Click the object whose link you want to replace.
7 On the Publisher Edit menu, click Paste Special. Publisher displays the Paste Special dialog box.
8 Click Paste Link, and then click OK. Publisher replaces the existing linked object with a link to the 

file you chose.



If you have problems using WordArt or the Clip Gallery

If you’re having difficulty adding WordArt or a Clip Gallery image to your publication, try this procedure:

WordArt
1 In the Explorer or File Manager, search for WRDART32.EXE.
2 In the Search Results window, double-click WRDART32.EXE.

A message will explain that WordArt can only be run from another application.
3 Click OK.

This will register WordArt so that applications can find it.

Clip Gallery
· Follow the procedure above, but search for and double-click ARTGALRY.EXE in steps 1 and 2.



If you have problems running a PageWizard design assistant

If you try to run one of the Publisher 97 PageWizard design assistants or Quick Demos, or the 
Introduction to Publisher, and you receive the error message “Cannot load custom control dll - C:\
Windows\System\mspubgxf.vbx,” you may be missing a dynamic link library (.dll) file, or it may be 
corrupted.

For the Publisher PageWizards to run correctly, the following files must be in your WINDOWS\SYSTEM 
directory:

Compobj.dll
Ole2.dll
Ole2disp.dll
Ole2nls.dll
Olethk32.dll

Windows keeps backup copies of these files in the \WINDOWS\SYSBCKUP directory. Try copying these 
files from that directory into your system directory. If that does not resolve the problem, you’ll need to 
reinstall Windows.



If you have problems printing on your desktop printer

Many different printing problems can be caused by outdated printer drivers. To be sure you’re using the 
correct type and version for your printer, consult your printer manual or contact your printer 
manufacturer. If you have access to the Internet, you may want to contact your printer manufacturer 
through the World Wide Web. Many printer manufacturers provide updated drivers on the Web.

Matching printed color to screen color
You will find that the colors in printed publications don’t always match the colors you see on your screen.
This is caused by the differences in the way that color monitors and color printers work.

On your monitor, the colors you see are made by mixing red, green, and blue glowing dots. Creating 
colors in this way is called additive mixing. In additive mixing, red, green, and blue can be used to create
any color of light, including white. 

On your printer, the colors you see are made by mixing various proportions of cyan, magenta, yellow 
(and sometimes black) inks. This is called subtractive mixing. In subtractive mixing, cyan, magenta, and 
yellow can be used to create any color of paint; if you mix equal amounts of them, you get black.

When you fill an object in a publication with aqua (the term Publisher uses for cyan), that color is made 
by mixing equal portions of green and blue light. Because the human eye is especially sensitive to blue 
and green light, this color appears very bright. When you print this object, it is colored with pure cyan ink.
When you look at this object on the printed page, however, you are actually seeing white light reflecting 
off of cyan ink. This makes the ink look less intense than the light coming from your monitor.



If you open a publication from a network and then can’t save it

If you open a publication from a network drive and the network server fails, or the network drive is 
disconnected, you may receive the following error message when you try to save the publication:

“Publisher cannot create a temporary working file.”

This error message may be repeated, and followed by one or more error messages about the disk being 
full. Once you have received these messages, the only way to save any changes you’ve made is to copy
the changed pages into a new publication, close the old publication, reopen it, and then copy the 
changed pages back in.

1 In your publication, turn to a page that you have changed.
2 On the Edit menu, click Select All.
3 On the Edit menu, click Copy.
4 Start a new session of Publisher, without closing the one you already have open.
5 In the new session of Publisher, click Paste on the Edit menu.
6 Repeat steps 1, 2, and 3 for each changed page, and then paste the contents of each page onto a 

new page in the second session of Publisher.
7 Save the new publication.
8 Exit the old publication without saving your changes.
9 Reopen the old publication, and copy into it the changed pages from the new publication.



What Publisher files do—and which files are optional

This section lists the directories that Publisher creates on your computer. Under each directory name is a
list of the files stored in that directory, a brief description of each file, and one of the following letter 
codes:

N: Necessary for Publisher to run. Deleting these files will result in Publisher not being able to run.
R: Recommended. Provides additional functionality for Publisher. Deleting these files will render some 

features of Microsoft Publisher non-functional.
O: Optional. Deleting these files will not cause any adverse effects.

Note
· If you delete any files and later want to replace them, use your original Publisher disks to run the 

Setup program and reinstall Publisher.

FONTS directory
MICROSOFT PUBLISHER directory
MICROSOFT PUBLISHER\BORDERS directory
MICROSOFT PUBLISHER\CLIPART directory
MICROSOFT PUBLISHER\PAPERS directory
MICROSOFT PUBLISHER\BACKGRND directory
MICROSOFT PUBLISHER\PAGEWIZ directory
MICROSOFT PUBLISHER\SETUP directory
MICROSOFT SHARED\TEXTCONV directory
MICROSOFT SHARED\GRPHFLT directory
MICROSOFT SHARED\WORDART directory
MICROSOFT SHARED\MSDRAW directory
MICROSOFT SHARED\ARTGALRY directory
MICROSOFT SHARED\PROOF directory
MICROSOFT SHARED\MSINFO directory
WINDOWS directory
WINDOWS\SYSTEM directory



MICROSOFT PUBLISHER directory

cheklist.jsp R Outside printing checklist
complinc.dll O Setup file used for online registration
hyph.dat R Hyphenation dictionary
infosheet.jsp R Outside printing info sheet
msoffice.hlp R Microsoft Office Compatible help topics
msoffice.gid O Index file for Office help file
mspub.exe N Microsoft Publisher program
mspub.m14 R Publisher help file
mspubpss.hlp O Microsoft technical support help
mspubpss.gid O Index file for technical support help file
pubmerge.dll R Used by Publisher’s mail merge feature
qmspub.hlp R Publisher quick tips help
qmspub.gid O Index file for quick tips help file
readme.hlp O This file
rulerfnt.fon N Font file used to display text on the ruler
wdbimp.dll R Used by Publisher’s mail merge feature to import information from Microsoft 

Works



BORDERS directory

*.bdr R Border files. Note that these files are required for the PageWizard design 
assistants to run correctly.



SETUP directory

With these files on your machine, you can quickly add or remove Publisher components by re-running 
setup. 

If you remove these files, you will not be able to uninstall Publisher. You can run Setup from your 
Publisher disk(s) anytime.



CLIPART directory

*.cag O Database of previews and index information for Publisher clip art. If you delete 
these files, your clip art will not appear in the Clip Gallery.

*.cgm, *.wmf, 
*.gif O Clip art files. See “The Publisher Companion” for a description of each file and 

its contents.



PAGEWIZ directory:

*.dll R These files are the PageWizards, Demos, and Intros.
*.poc R These files are required by Publisher’s PageWizard design assistants.
*.prv R These files contain the previews for each PageWizard design assistant.
*.pub R These files are required by Publisher’s PageWizard design assistants. Files 

that begin with Class, Jazzy, Mod, or Plain are Design Gallery design sets.
*.reg O These files contain system registry information for Publisher Setup, and they 

configure PageWizards to run correctly.



PAPERS directory

papers.ini O List of PaperDirect papers that can be viewed in Publisher. Necessary if you 
are using Special Papers.

*.wmf O Background paper files. These files contain images of paper that you can view 
in Publisher.



BACKGRND directory

*.gif R Graphics for Web page backgrounds. Note that some of these files are 
required for the Web Site PageWizard design assistants to run correctly.

*.reg R These files contain system registry information for Publisher's Web Page 
background schemes. Some of these files are also used by the Web Site 
PageWizard. 



WINDOWS directory

twain.dll R Scanner support file
twain_32.dll R Scanner support file
twunk_16.dll R Scanner support file
twunk_32.dll R Scanner support file



WINDOWS\SYSTEM directory

ctl3d32.dll R On Windows NT 3.51, provides 3-d dialog boxes*
mfc40.dll N Used by Publisher, the Clip Gallery, and WordArt*
mfcans32.dll N Used by Publisher, Microsoft Draw, and Clip Gallery*
mfcuia32.dll R Used by Microsoft Draw*
msgenbw.ppd R Used by Publisher for outside printing
msgencol.ppd R Used by Publisher for outside printing
msjt3032.dll R Used by Publisher for mail merge*
msjter32.dll R Used by Publisher for mail merge*
msjint32.dll R Used by Publisher for mail merge*
mspub.inf R Used by Publisher for outside printing
mspubgxf.vbx R Used by PageWizard design assistants
mspubpg.vbx R Used by PageWizard design assistants
mspubq32.dll R Used by PageWizard design assistants
mspubw32.dll R Used by PageWizard design assistants
msrd2x32.dll R Used by Publisher for mail merge*
msxb3032.dll R Used by Publisher for mail merge*
mstx3032.dll R Used by Publisher for mail merge*
msxl3032.dll R Used by Publisher for mail merge*
msvcrt20.dll N Used by Publisher and the Clip Gallery*
msvcrt40.dll N Used by Publisher and the Clip Gallery*
mv*.dll R Used by Publisher to display help*
pcdlib32.dll R Used by the Kodak Photo CD graphics filter*
picstore.dll R Used by the Clip Gallery
printer.inf R Used by Publisher for outside printing
pub3brsh.ani R Used by Publisher as a wait cursor
pubole32.dll N Used by Publisher and WordArt to support OLE
pubdlg.dll N Used by Publisher and the Clip Gallery
spin.vbx R Used by Publisher’s PageWizard design assistants*
threed.vbx R Used by Publisher’s PageWizard design assistants*
tw1632.dll R Used by Publisher to install TWAIN*
vbajet32.dll R Used by Publisher for mail merge*
vbar2232.dll R Used by Publisher for mail merge*
vbrun300.dll R Used by Publisher’s PageWizard design assistants*
ven2232.olb R Used by Publisher for mail merge*

* Do not remove this file because it may be used by another program.



MICROSOFT SHARED\GRPHFLT directory

Use Publisher Setup to add or delete graphic filters.

bmpimp32.flt O BMP import filter - Windows bitmaps
cdrimp32.flt O Corel Draw! import filter
cgmimp32.flt R CGM import filter - Computer Graphics Metafile. This filter is required for the 

PageWizard design assistants to run correctly.
drwimp32.flt O DRW import filter - Micrografx Draw/Designer
epsimp32.flt O EPS import filter - Encapsulated PostScript
gifimp32.flt O GIF import filter - Graphics Interchange Format
jpegim32.flt O JPEG import filter
msbmp32.dll O BMP import filter - Windows bitmaps
msjpeg32.dll O JPEG import filter
mspcd32.dll O Kodak PhotoCD filter
mspcx32.dll O Windows Paintbrush filter
mstiff32.dll O TIFF import filter - Tagged Image File Format
pcdimp32.flt O Kodak PhotoCD filter
pcximp21.flt O Windows Paintbrush filter
tiffim32.dll O TIFF import filter - Tagged Image File Format
wmfimp32.flt R WMF import filter - Windows Metafile. This filter is required for the PageWizard 

design assistants to run correctly.
wpgexp32.flt O WordPerfect graphics filter. Used by the WordPerfect text converter
wpgimp32.flt O WordPerfect graphics filter.



Fonts

In Windows 95, fonts are installed in the WINDOWS\FONTS folder.

In Windows NT, fonts are installed in the WINDOWS\SYSTEM directory.

Use Publisher Setup to add the group of fonts installed by Publisher. Use the control panel in Windows 
95 or Windows NT to remove fonts.



MICROSOFT SHARED\WORDART directory

qwrdrt32.gid O Index file for quick tips help
qwrdrt32.hlp R WordArt quick tips help
wrdart32.cnt R Contents for WordArt help
wrdart32.exe N Runs WordArt
wrdart32.fts O Full-text search for WordArt help
wrdart32.gid O Index file for WordArt help
wrdart32.hlp R WordArt help file



MICROSOFT SHARED\ARTGALRY directory

artgalry.cag N Database file for the Clip Gallery’s previews and index
artgalry.cnt R Contents for the Clip Gallery help file
artgalry.dll R Runs Microsoft Clip Gallery
artgalry.exe O Used to download clips from the World Wide Web
artgalry.gid O Index for help file
artgalry.hlp R Microsoft Clip Gallery help file
artgalry.srg R Registers Clip Gallery
qartgalry.hlp O Quick tip help file
www_clip.url R Shortcut to Clip Gallery Live! on the World Wide Web



MICROSOFT SHARED\MSDRAW directory

msdraw.cnt O Contents for help file
msdraw.exe O Runs Microsoft Draw
msdraw.gid O Index for Microsoft Draw help file
msdraw.hlp O Microsoft Draw help file



MICROSOFT SHARED\PROOF directory

custom.dic R Custom dictionary
mssp2_en.lex R Spelling Checker dictionary
mssp232.dll R Spelling Checker



MICROSOFT SHARED\TEXTCONV directory

These files allow you to convert a word-processing document to the Publisher format, or take text 
created in Publisher and bring it into your word processor. Use Publisher Setup to delete one or all of 
these, depending on the kind of word processor you want to use to create files you’ll bring into Publisher.

Msconv32.dll R Used by some of the text converters
mswrd632.cnv O Microsoft Word 6.0 or 7.0 text converter. Can only be used for importing text 

into Publisher
wnwrd232.cnv O Microsoft Word for Windows 2.X text converter
works332.cnv O Microsoft Works for Windows 3.0 text converter
works432.cnv O Microsoft Works for Windows 95 text converter
wpft532.cnv O WordPerfect 5.0 text converter
wpft632.cnv O WordPerfect 6.x text converter
wrd6ex32.cnv O Microsoft Word 6.0 export text converter
write32.cnv O Windows Write text converter



MICROSOFT SHARED\MSINFO directory

imgwalk.dll N MS Info system file
msinf16h.exe N MS Info file which allows older programs to communicate with MS Info
msinfo.exe N Microsoft System Information tool used by programs to detect information 

about your computer and its software
msinfo32.gid O Index for help file
msinfo32.hlp R MS Info help file



If you can’t find the Special Paper command

Due to limited availability of PaperDirect paper outside the United States, the Special Paper feature is 
not available in all versions of Publisher sold outside the United States and Canada.



If you have problems using scanners and imaging hardware with Publisher

Publisher communicates with scanners and other imaging hardware by using a software component 
called TWAIN.

If your scanner does not work with this release of Publisher, you can probably solve the problem by 
obtaining an updated set of the TWAIN software components. To obtain a new version of TWAIN:
· Contact the manufacturer of your scanner. Your scanner manufacturer will have current information 

on how to solve problems with the scanner and TWAIN.

If you have access to CompuServe or FTP, you can obtain new TWAIN software over your modem.
· On CompuServe, type GO HPPERIPH to access the Hewlett Packard Peripherals forum, and 

look in the TWAIN section for new releases of TWAIN. 
· On FTP, use anonymous FTP to ftp:caere.com//pub/twain.

If neither of the above solutions works, contact Microsoft Technical Support. For information on 
contacting Microsoft Product Support Services, see the file MSPUBPSS.HLP in the Publisher directory 
on your computer.

For more information on TWAIN, see “The Publisher Companion.”



If you’re planning to have your Publisher files printed by a professional printer or
service bureau

Files created in Microsoft Publisher 97 or Publisher for Windows 95 can be printed by almost any 
professional printer or service bureau. The printer does not need to have Publisher installed. To work 
with a printer who does not have Publisher, you create a PostScript file that can be printed from either 
Macintosh or PC equipment. Publisher can also create spot-color separations for high-quality, low-cost 
color printing.

If you’ve never worked with a professional printer before, we recommend you read the “Printing” chapter 
in “The Publisher Companion” first. It can save you time and money, and help you get the results you 
want.



Enhance your Microsoft Publisher 97 creative design with professional 
photography!
A powerful edge
PhotoDisc award-winning photos give you a powerful edge for business and all creative 
communications, including brochures, Web pages, advertising, presentations, and more. Now you can 
get more visible impact with PhotoDisc images. The enclosed images from the PhotoDisc collection of 
stock photographs are available to you with a click of the mouse—right from Publisher. These images 
will jump-start your imagination as you create professional-looking designs. When you are ready for 
more images or need high-resolution images, contact PhotoDisc online or by phone.

We’ve taken care of everything for you
As the highest-rated producer of professional digital photography, PhotoDisc has the keys to getting the 
image right, every time. Each photograph is chosen from the portfolios of award-winning photographers, 
carefully scanned with the highest quality scanning technology, color-corrected and stored in full color for
dazzling impact. 

Ready for more?
The PhotoDisc digital photography series currently features over 60 high-resolution Volumes on CD-
ROM, and a broad offering of subjects and over 50,000 images available online. Approximately 4,000 
new images are released every quarter. PhotoDisc Volume subjects range from Business to Italian Fine 
Art to American Retro images and Everyday Objects.

In a hurry? Look to PhotoDisc’s World Wide Web site for incredible image-searching tools and 
immediate single image purchase and downloading!

Accessing PhotoDisc Images from Publisher 97
1 Create a picture frame, or click an existing picture frame.
2 On the Insert menu, click Clip Art.
3 Click the Pictures tab.
4 Click the image you want, and then click Insert.

Licensing
Look to your Microsoft End User License Agreement and “The Publisher Companion” for complete 
information.

For more information about PhotoDisc, please contact PhotoDisc directly.

Please call or fax for a FREE product catalog or for further assistance.

Within the US (800) 528-3472
Fax: (206) 441-9379

Outside the US (206) 441-9355
Fax: (206) 441-9379

From Europe + 44 (0) 181 332 2020
Fax: + 44 (0) 181 1506 461 510

UK Free Phone 0800 697 622

Online 

http://www.photodisc.com
Internet: sales@photodisc.com or techsupport@photodisc.com



No other source can provide you with images of such high quality and breadth, royalty-free and 
ready for immediate use.

PhotoDisc Inc.
2013 4th Avenue
Seattle, WA 98121
USA

PhotoDisc Europe Ltd.
The Old Workshop
Retreat Road
Richmond
Surrey TW9 1NN
United Kingdom

Copyright 1996 PhotoDisc, Inc.



Accessibility for people with disabilities

Microsoft is committed to making its products and services easier for everyone to use. This help file 
provides information about the following features, products and services, which make Microsoft 
Windows, Microsoft Windows NT and Microsoft Publisher more accessible for people with disabilities:

Microsoft services for people who are deaf or hard-of-hearing
Customizing Windows or Windows NT
Keyboard layouts for single-handed users
Obtaining Access Packs, Application Notes, and alternative keyboard layouts
Microsoft documentation in alternative formats
Third-party utilities to enhance accessibility
Getting more accessibility information

The information in this section applies only to users who purchased Windows or Windows NT in the 
United States. If you purchased Windows or Windows NT outside the United States, your Windows 
package contains a subsidiary information card listing Microsoft support services telephone numbers. 
You can contact your subsidiary to find out whether the type of products and services described in this 
help file are available in your area. 



Microsoft services for people who are deaf or hard-of-hearing

Through a text telephone (TT/TDD) service, Microsoft provides people who are deaf or hard-of-hearing 
with complete access to Microsoft product and customer services.

Sales information

You can contact Microsoft Sales Information Center on a text telephone by dialing (800) 892-5234 
between 6:30 A.M. and 5:30 P.M. Pacific time. 

Technical assistance

For technical assistance in the United States, you can contact Microsoft Support Network on a text 
telephone at (206) 635-4948 between 6:00 A.M. and 6:00 P.M. Pacific time, Monday through Friday, 
excluding holidays. In Canada, dial (905) 568-9641 between 8:00 A.M. and 8:00 P.M. Eastern time, 
Monday through Friday, excluding holidays. Microsoft support services are subject to Microsoft prices, 
terms, and conditions in place at the time the service is used.



Obtaining Access Packs, Application Notes, and alternative keyboard layouts

If you have a modem, you can download these files from the following network services:

· Microsoft’s World Wide Web site on the Internet. On the www.microsoft.com home page, click the 
Support icon, click Knowledge Base, and select MS-DOS as the product. Enter KBFILE 
GA0650.EXE, and click GO. Open the article, and click the button to download the file.

· Microsoft’s Internet servers, ftp.microsoft.com and gopher.microsoft.com, in /softlib/mslfiles
· MSN, The Microsoft Network online service
· CompuServe®

· GEnie™

· Microsoft Download Service (MSDL), which you can reach by calling (206) 936-6735 any time except 
between 1:00 A.M. and 2:30 A.M. Pacific time. MSDL supports 1200, 2400, 9600, 14400, or 28800 
baud rates (V.32 and V.42), with 8 data bits, no parity, and 1 stop bit.

· Various user-group bulletin boards (such as the bulletin-board services on the Association of PC User
Groups network)

Ordering Access Packs, Application Notes, and alternative keyboard layouts on disks

If you do not have a modem, within the United States you can order the Access packs, Application 
Notes, and alternative layouts on disks by calling Microsoft Sales Information Center at (800) 426-9400 
(voice) or (800) 892-5234 (text telephone). In Canada, you can call (905) 568-3503 (voice) or (905) 568-
9641 (text telephone).



Keyboard layouts for single-handed users

Microsoft distributes Dvorak keyboard layouts that make the most frequently typed characters on a 
keyboard more accessible to people who have difficulty using the standard "QWERTY" layout. There are
three Dvorak layouts: one for two-handed users, one for people who type with their left hand only, and 
one for people who type with their right hand only. The left-handed or right-handed keyboard layouts can
also be used by people who type with a single finger or a wand. You do not need to purchase any 
special equipment in order to use these features.
Microsoft Windows and Microsoft Windows NT already support the two-handed Dvorak layout, which 
can be useful for coping with or avoiding types of repetitive-motion injuries associated with typing. To get
this layout use the Windows Control Panel; consult your online documentation for detailed instructions. 
The two layouts for people who type with one hand are distributed as Microsoft Application Note 
GA0650. It is also contained in file GA0650.EXE on most network services and on the Microsoft 
Download Service. 
For instructions on ordering this application note, see Obtaining Access Packs, Application Notes, and 
alternative keyboard layouts.



Microsoft documentation in alternative formats

If you have difficulty reading or handling printed documentation, you can obtain many Microsoft 
publications from Recording for the Blind & Dyslexic, Inc. Recording for the Blind & Dyslexic distributes 
these documents to registered eligible members of their distribution service either on audio cassettes or 
on floppy disks. The Recording for the Blind & Dyslexic collection contains more than 80,000 titles, 
including Microsoft product documentation and books from Microsoft Press. You can contact Recording 
for the Blind & Dyslexic at the following address or phone numbers for information on eligibility, and on 
the availability of Microsoft product documentation and books from Microsoft Press: 
Recording for the Blind & Dyslexic, Inc.
20 Roszel Road
Princeton, NJ 08540
Phone: (609) 452-0606
Fax: (609) 987-8116
World Wide Web: http://www.rfbd.org



Third-party utilities to enhance accessibility

A wide variety of third-party hardware and software products are available to make personal computers 
easier to use for people with disabilities. Among the different types of products available for the MS-
DOS, Microsoft Windows, and Microsoft Windows NT operating systems are:
· Programs that enlarge or alter the color of information on the screen for people with visual 

impairments.
· Programs that describe information on the screen in Braille or synthesized speech for people who are

blind or have difficulty reading.
· Hardware and software utilities that modify the behavior of the mouse and keyboard.
· Programs that enable users to “type” using a mouse or their voice.
· Word or phrase prediction software that allows one to type more quickly and with fewer keystrokes.
· Alternate input devices, such as single switch or puff-and-sip devices, for those who cannot use a 

mouse or a keyboard.
To learn more about these products, see Getting more accessibility information. 



Customizing Windows or Windows NT

There are many ways you can customize Windows or Windows NT to make your computer more 
accessible.
Beginning with Windows 95, accessibility features are built into Windows. These features are useful for 
individuals who have difficulty typing or using a mouse, have moderately impaired vision, or who are 
deaf or hard-of-hearing. The features can be installed during setup, or you can add them later from your 
Windows 95 installation disks. Look up “accessibility” in the Windows Help Index for information about 
installing and using these features
Many of the features which make Windows 95 more accessible can be added to Windows NT through 
Access Packs. You can download these files by modem, or you can order them on disk from Microsoft.
You can also use the Control Panel and other built-in features to adjust the appearance and behavior of 
Windows or Windows NT to suit varying vision and motor abilities. These options include adjusting 
colors and sizes, sound volume, and the behavior of the mouse and keyboard.
Dvorak keyboard layouts make the most frequently typed characters on a keyboard more accessible if 
you have difficulty using the standard “QWERTY” layout. There are three Dvorak layouts: one if you are 
a two-handed user, one if you type with your left hand only, and one if you type with your right hand only.
You do not need to purchase any special equipment to use these features.
For full documentation on the accessibility features available in the operating system you are using, 
obtain the appropriate application notes listed below. Accessibility features are also documented in the 
Microsoft Windows 95 Resource Kit and the Microsoft Windows NT Resource Kit.

For You need
Application notes for Microsoft Windows 95 WW1062.EXE
Application notes for Microsoft Windows NT 3.1 and 3.5 WN0789.EXE
(includes Access Pack for Microsoft Windows NT)
Dvorak keyboard layouts for people who type with one hand GA0650.EXE
(already included in Windows NT 3.5 and higher)

For instructions on obtaining these, see Obtaining Access Packs, Application Notes, and alternative 
keyboard layouts.



Getting more accessibility information

Microsoft products and services

For more information, contact: 
Microsoft Sales Information Center
One Microsoft Way
Redmond, WA 98052-6393
Voice telephone: (800) 426-9400
Text telephone: (800) 892-5234
Fax: (206) 635-6100
World Wide Web: http://www.microsoft.com

Directories of computer products for people with disabilities

The Trace R&D Center at the University of Wisconsin-Madison produces a book and a compact disc that
describe products that help people with disabilities use computers. The “Trace ResourceBook” provides 
descriptions and photographs of about 2,000 products. The compact disc, “Co-Net CD,” provides a 
database of more than 18,000 products and other information for people with disabilities. It is issued 
twice a year. To obtain these directories, contact:
Trace R&D Center
S-151 Waisman Center
1500 Highland Avenue
Madison, WI 53705–2280
World Wide Web: http://trace.wisc.edu
Fax: (608) 262-8848

Referrals to assistive technology programs and trained evaluators
For general information and recommendations on how computers can help specific people with specific 
needs, you should consult a trained evaluator. An assistive technology program in your area will provide 
referrals to programs and services that are available to you. 
To locate the assistive technology program nearest you, contact:
National Information System 
University of South Carolina
Center for Developmental Disabilities
Benson Building
Columbia, SC 29208
Voice/text telephone: (803) 935-5200
Fax: (803) 935-5250




